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about WordPress 
WordPress is a personal publishing system which is easy to use and fast. 
WordPress allows you to create your own web pages and blog entries. It is possible 
to upload documents, sound, video and pictures to your ePortfolio. You can choose 
to share your posts with everyone, your lecturer or keep them personal to yourself. 
You have a few themes to choose from which are designed to allow you to 
customize your portfolio. If you are unsure of the meaning of some terms in this 
manual, please see the glossary on page 10. 

your Homepage 
There are two ways to view your ePortfolio. You can type the web address into a 
browser window directly as https://www.dgmyspace.dumgal.ac.uk/eportfolio/ 

followed by your student ID number so for example if your student id is 1234567 
you would enter https://www.dgmyspace.dumgal.ac.uk/eportfolio/1234567 

Note: to login you would need to add /wp-admin to the end of your portfolio 
address and use your student ID and college password to login e.g. 
https://www.dgmyspace.dumgal.ac.uk/eportfolio/1234567/wp-admin  
 
Alternatively, you can Login to LearnNet and click on the Your Portfolio button on the 
dashboard (right hand side on desktop, scroll down on mobile). 

     

http://www.dgmyspace.dumgal.ac.uk/eportfolio/
http://www.dgmyspace.dumgal.ac.uk/eportfolio/
https://www.dgmyspace.dumgal.ac.uk/eportfolio/1234567
https://www.dgmyspace.dumgal.ac.uk/eportfolio/1234567/wp-admin
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This section of LearnNet will provide you with a direct link to your ePortfolio. Click on 
the link provided to access it. 

  

Once on your ePortfolio, you should see a screen like the one below (although you 
should see your own name or student number!). If you are using a mobile device, it 
will look simpler. 

 

 

 



 
 

Dumfries and Galloway College 07 Oct 2021 pg. 5  
 

If you don’t see this, check that you have typed the address and your student 
number                  correctly (and in lower case). If the page still won't work, tell your lecturer 
because it's          possible that your ePortfolio hasn't been set up yet! 

Later in this tutorial you will see how to start editing and posting your own 
information. 

Once you have successfully logged in you will see a bar at the top of your 
ePortfolio like this one: 

(DESKTOP VIEW) (MOBILE VIEW) 

 

 
 

the Dashboard 
To access the dashboard (which is where you 
create and manage your ePortfolio) click the site-
admin link in the meta menu in the side bar or 
hover over “Your Name” (top left) to reveal the 
admin menu. 

If you are on a mobile all you need to do is tap the 
dashboard icon (it looks a bit like the speed-o-
meter    on a car dashboard) to reveal the menu and 
click on  “Dashboard” 

 More Info: https://ewp.guide/go/dashboard  

https://ewp.guide/go/dashboard
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Edit your Profile 
First things first: you probably want to update your 
profile? The easiest way to do this is to hover over 
your name on the far right of the top bar and click the 
edit my profile link at the top right of the page. You 
will be presented with your profile and personal 
options. 

On Mobile tap the empty avatar picture to reveal the 
menu and tap on “Edit Profile”. 

 More Info: https://ewp.guide/go/editing-your-profile  

EDITOR OPTIONS 

The options are mostly for entering information about yourself, changing editor 
options and your colour schemes. 

CHANGING YOUR AVATAR 

WordPress uses Gravatar for your avatar. The avatar that is displayed is called a 
Gravatar. A Gravatar is a Globally Recognized Avatar. To create a Gravatar, simply 
go to gravatar.com  and sign up. To use your Gravatar within WordPress, simply 
use the same email address in your Profile that you’ve configured within the 
Gravatar site and it will automatically display 

https://ewp.guide/go/editing-your-profile
https://www.gravatar.com/
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Customizer 

EDITING YOUR SITE TITLE 

By default, the Site Title will be set to “Your Name” you 
will want to change this. To do this hover over 
“Appearance” then click on “Customize” 

 
On Mobile tap the hamburger menu (looks like 3 stacked horizontal lines) to reveal 
the admin menu then tap on “Appearance” to reveal the appearance menu and 
tap on “Customize”. This area will allow you to customize the theme installed on 
your ePortfolio and will look like below: 

Desktop Mobile 
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Click on “Site Identity” to change the title of your 
ePortfolio. Enter your name or the title of your ePortfolio 
into the field labelled “Site Title”. You can also enter in a 
short one-line description of your ePortfolio in the field 
labelled “Tagline”. 

There is also an optional field to add a .ico icon to act as 
your ePortfolio icon. This appears in the tab in your 
browser. You can create one for free using 
https://favicon.io/ 

Once you have finished making your changes the “Publish” button will change to 
blue and can be clicked. Click the button to save your changes. 

MORE OPTIONS 

There are many more options available in Customizer. You can find out about 
each option here: https://ewp.guide/go/customizing-your-site 

Posts and Pages 

WHAT IS THE DIFFERENCE? 

There is an important difference between pages and posts (posts appear under 
the categories heading). Pages are filled with fixed information; a good example 
would be your Curriculum Vitae (CV from now on). Although your CV changes, the 
CV page is always present, and you edit it when you need to add something new. 
Posts on the other hand happen at a given time. If you are familiar with blogging, 
posts are like blog entries. If you are not sure about blogging, blogs can best be 
described as diaries which display the latest entry first. They are a good way to 
build up evidence of your activities for an ePortfolio. 

https://favicon.io/
https://ewp.guide/go/customizing-your-site
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Example POSTs: 

1. You apply for a job at a local company and get an interview. You could 
write a post about your experiences and file it under 'career opportunities', 
whether you get the job or not the work you have done to get the interview 
is important. 

2. You are training to take part in a sporting event. You can write a post about 
your experiences and file under 'improving my skills'. 

Example PAGEs: 

1. Your CV: If you wish to note your new job title and all of your responsibilities, 
the best place to do this would be your CV. Simply edit your CV when you 
have something to add. 

2. My Qualifications: It makes sense to summarise all of your qualifications on 
one page. If you get more qualifications, add them to this page. 

Making a New Page 
Pages are the basic requirements for your ePortfolio and can easily be edited by 
clicking on “Pages” in the menu and then clicking on the title of the page you want 
to edit. You can easily add new pages when you need them. You can call the 
pages anything you like. To make a new page hover on the new link on your 
dashboard then click the page link or visit the pages area in the dashboard and 
click the Add New button. You will find there are a few ways of achieving things so 
just use whatever method suits you best. 

 

NOTE: 
You can use a password protected page on your site for (optionally) 
storing anything personal. You can choose what password you set it as.  
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MAKING A NEW POST  

Making a new post is very similar to making a new page. 
When you create a post, you should try your best to 
choose a category for the post by clicking the checkbox 
next to that category. You can add new ones by clicking “+ 
Add New Category” 

 Publish Settings 
Posts are public unless saved as a draft, private or set as 
password protected. 

By default every post will default to Publish after you click 
the blue “Publish” button.  

If you aren’t ready to publish a post or page you can click 
the “Switch to draft” link (top right, to the left of the 
update button). This will save the post or page as a draft 
version that is only visible to yourself. 

If you want to keep a post private (so it’s only visible to 
yourself), Open the settings tab in your editor and click 
the Post tab. Then open the “Status and Visibility” section. Click 
the blue link next to “Visibility” this will give you more options to 
choose for. Set this to Private then click the blue “Update” 
button to save.  

If you want to share a post only with your lecturer, then you will 
need to change it to “Password Protected” and set a 
password. Go to the “Status and Visibility” section and 
change it to “Password Protected” a small field will appear 
where you can input a password for that post. Save the post 
then share your post’s password with your lecturer so they can 
access it.  
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Existing posts can be edited by clicking on “posts” and then clicking on the title of 
the post you want to edit. 

USING THE POST / PAGE EDITOR 

You can find out more about the editors and how to use them here:  

 Block Editor: https://ewp.guide/go/be/block-editor 

NOTES ABOUT FILES AND SIZES 

Although WordPress will resize images when you upload them, you don’t want to 
be uploading huge files as they can be slow to upload and load if you are on a 
slow internet connection. You also want to make sure they are using the right file 
type for the web. 

Supported Image File Types are as follows: 
• .jpg (sometimes also appear as .jpeg) 
• .gif 
• .png 

For the most part you will want to save your file as a jpg. However, if you need 
transparency you might want to use a png file instead. 

Size wise while WordPress will resize your photos for you it’s best not to upload 
huge high-resolution images because it will take a long time to upload and load 
on your website, it may even be too big to be uploaded. You can resize your 
images before upload if you need to. It can also be worth running it through a 
compressor to optimize it for the web. 

We’ve included some tools to help you: 
• Online Image Resize : https://www.photopea.com/ 
• Image Compressor: https://shortpixel.com/online-image-compression 

https://ewp.guide/go/be/block-editor
https://www.photopea.com/
https://shortpixel.com/online-image-compression
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If you are on a mobile there is a free app called “Image Size” that can help you with 
resizing. 

Supported Video File Types are as follows: 
• .mp4, .m4v (MPEG-4) 
• .mov (QuickTime) 
• .wmv (Windows Media Video) 
• .avi 

• .mpg 
• .ogv (Ogg) 
• .3gp (3GPP) 
• .3g2 (3GPP2) 

We do encourage you to upload videos onto services like YouTube or Vimeo where 
possible. However, don’t use copyrighted music on these services as this could get 
you banned. 

Other Supported Files 

To see the full list of supported files visit: 

 https://codex.wordpress.org/Uploading_Files  

https://codex.wordpress.org/Uploading_Files
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Block Editor 

ADDING AN IMAGE  

There is more than one way to add an image in the new Block Editor so we will only 
show you the simplest method here. 

First click either the blue “+” button (top left) or the black “+” button in the editor 
(this should say “Add Block” when you hover over it. 

When clicked this will show a range of the commonly used 
blocks including “Image”.  You can search for a block by 
typing a keyword in the search field. You can also Browse 
all Blocks to see all the options. Click on the “Image” block. 

The Paragraph Block will now convert to an Image Block 
where you have the option to upload an image, choose 
from an existing image or insert from a URL. 

There are a number of options in the toolbar at the top of 
the image block. You can choose to transform it into a different kind of block.  Add 
a default style to the block (rounded or square).  
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You can change the alignment of the image. 

To change the image to a lightbox image you can 
link it to the media file by clicking the chain link icon. 

You can also crop or replace the image. 

To resize the image, you can drag the blue dots to  
the right and bottom of the image. 

On the far-right sidebar, you will also see the options to add “Alt text” which is used 
by screen readers and change the image size. 

Just below the image a field for adding a caption has been added along with 
some basic styling options including “bold”, “italic” and link. You can type directly 
into this field. 

For more information visit: 

  https://ewp.guide/go/be/image-block 

Other Blocks Include: 

 Cover Block: https://ewp.guide/go/be/cover-block 

 Media & Text Block: https://ewp.guide/go/be/media-text-block 

ADDING A GALLERY  

Adding a gallery of images is very similar to how you add 
a single image. Instead of selecting the “Image” block 
however you should look for a select the “Gallery” block. 

Like the image block you can upload or choose from 
existing images to add to your gallery. 

You can then enter in captions and drag your images into 
the correct order before clicking “Insert Gallery” to add to your block. 

https://ewp.guide/go/be/image-block
https://ewp.guide/go/be/cover-block
https://ewp.guide/go/be/media-text-block
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Once added you will find you can edit captions directly on the images as well as 
edit the options in the block options in the sidebar to the right. This allows you to 
change the number of columns, allow thumbnail cropping and link them to the 
“Media File” (this means they will open in the lightbox.) 

 
For More Information: 

  https://ewp.guide/go/be/gallery-block 

https://ewp.guide/go/be/gallery-block
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ADDING A VIDEO  

To add a video from YouTube or Vimeo click “Add Block” and 
search for “Video” this will show you a number of options. 
Click “YouTube”. 

Paste your YouTube URL that you got from the Share button 
on your YouTube video and click “Embed” 

 

The embedded video will now appear in your editor along with an option to add a 
caption. 

To upload your own video to your ePortfolio you should choose the 
Video Block. Once uploaded you will also have a number of control 
settings to choose from in the block settings sidebar to the right. 

 
 



 
 

Dumfries and Galloway College 07 Oct 2021 pg. 18  
 

For more Information visit:  

 Embeds - https://ewp.guide/go/be/embeds 

 Video Block - https://ewp.guide/go/be/video-block Audio Block - 
https://ewp.guide/go/be/audio-block 

ADDING A LINK  

Adding a link in the block editor is really simple. Just paste the URL into an empty 
paragraph block and it will change into the relevant block. If it’s unable to embed it 
just click the button marked “Convert to link”. 

To edit the settings, click once on the link then click “Edit” to change the link text. 
You can also force it to open in a new tab by clicking on the “Open in New tab” 
toggle. 

 
For More Information : 

 Paragraph Block : https://ewp.guide/go/be/paragraph-block  

 Embeds - https://ewp.guide/go/be/embeds 

ADDING A QUOTATION  

There are a number of different quotation blocks you can use in the block editor. 
Just search for “Quote” and have a play with the settings on each (Pullquote is 
probably the simplest of all of them). All three options have a field for adding the 
citations below the quote. 

https://ewp.guide/go/be/embeds
https://ewp.guide/go/be/video-block
https://ewp.guide/go/be/audio-block
https://ewp.guide/go/be/paragraph-block
https://ewp.guide/go/be/embeds
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For More Information : 

 Pullquote Block : https://ewp.guide/go/be/pullquote-block Quote 
Block : https://ewp.guide/go/be/quote-block 

 Verse Block : https://ewp.guide/go/be/verse-block 

note about Accessibility 
It is good practice to make your content accessible for users with disabilities. This 
can include a wide range of disabilities including dyslexia, visual impairments, 
hearing difficulties and muscle weakness. There are some simple things you can 
do to make your content accessible.  

These include: 
• Always adding alt tags to your images that describe your image 
• Adding Captions to your images and videos 
• Adding Transcripts to your Videos and audio files (YouTube can 

automatically transcribe your videos – although it can be worth going 
through and double checking them) 

• Add titles to your links. 
• Keep a good contrast between your text and your text background. 

If you are interested in learning more about this visit: 

https://ewp.guide/go/be/pullquote-block
https://ewp.guide/go/be/quote-block
https://ewp.guide/go/be/verse-block
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  https://www.w3.org/WAI/perspective-videos/ 

Lightbox Plugin 
Your ePortfolio should have the Simple Lightbox Plugin installed. 

If this is not working, go to the plugins section in the admin area. This will show you 
a list of plugins. Look for the “Simple Lightbox Plugin” and check it is activated. 

 

If it is not appearing as above, click the link “Activate” to activate. 

If it is activated and still not working check that you have set your images to be 
linked to the “Media File” this must be set for the lightbox functionality to work. 

If the plugin is missing or the lightbox functionality is not working let your tutor 
know as there may be an issue that needs to be looked at further. 

when you leave College 
When you leave College, you need not lose the work you have done on your 
ePortfolio. Ask your personal tutor to get an 'export' of your ePortfolio. You will 
receive a WordPress XML file which you can use to import into your new WordPress 
host. If you need help with this instructions on what to do can be provided. 

Updates 
Updates are managed by Dumfries and Galloway College so you do not need to 
worry about this . 

https://www.w3.org/WAI/perspective-videos/
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Image Resources / help with WordPress 
Rather than present you with vast amounts of information about how to use your 
ePortfolio we instead direct your attention to the following resources which will 
provide you with as much or as little help as you may need to manage your 
ePortfolio. 

WORDPRESS RESOURCES 

There is a free online guide to using WordPress, which is kept up to date, available 
here: https://easywpguide.com/wordpress-manual/ you can also download it 
as a PDF. 

• Overview of WordPress 5 (YouTube Video) 
https://www.youtube.com/watch?v=jmqu4HC3zmo 

• Wordpress.org have their own tutorial pages. 
https://codex.wordpress.org/Main_Page   

• and a forum to help you https://wordpress.org/support/ 

ONLINE IMAGE GENERATORS / RESOURCES  

• Favicon Generator : https://favicon.io/ 
• Online Image Resizer : https://www.photopea.com/ 

➢ Click File -> Open -> select your file 
➢ Go to Image -> Image Size to resize. 
➢ Click File ->Export As -> JPG (or PNG) 

• Image Compressor: https://shortpixel.com/online-image-compression 
 

There are also Image Resize Apps available for your mobile device. 

 Apple App Store : Image Size Google Play Store : Image Size 

If you require any further information, please get in touch with your tutor.  

https://easywpguide.com/wordpress-manual/
https://www.youtube.com/watch?v=jmqu4HC3zmo
https://codex.wordpress.org/Main_Page
https://wordpress.org/support/
https://favicon.io/
https://www.photopea.com/
https://shortpixel.com/online-image-compression
https://apps.apple.com/gb/app/image-size/id670766542
https://play.google.com/store/apps/details?id=de.vsmedia.imagesize&hl=en_GB
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Glossary 
WordPress:  WordPress is the blogging software we use to create student 

ePortfolios. Find out more about WordPress at 
https://wordpress.org/ 

EPortfolio:  Your ePortfolio can be thought of as a web page which stores a 
diary of your achievements. 

Blog:  A blog is a set of articles written by someone to tell others what 
they are doing, how they feel or to comment on a subject. 

Theme:  A theme in your ePortfolio is a set of styles to help you 
personalise how your site looks. 

Dashboard:  The Dashboard in WordPress is where you manage all of your 
pages, posts and media files. 

UAM:  User Access Management.  
This is a plugin we use to allow you to restrict who can see your 
entries (you, your lecturer or everyone). 

https://wordpress.org/
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